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Chapter 1

Getting Started

The Galil Communication Library (gclib) is a communication library for Galil motion controllers and PLCs. A number
of programming languages, operating systems, and hardware platforms are supported.

The library consists of a basic set of function calls (gclib.h), and an open-source extension library (gclibo.h). A
number of examples are provided to demonstrate how to use the library with various languages.

The gclib will import virtually anywhere a dll/so/dylib can be imported. See installation for details. Please contact
support@galil.comif the language or platform required is not listed.

Contents

* List of all functions

« Installation and supported operating systems
+ Language Support

» Using gclib

« Example Projects

Release Notes

See the update history of gclib inthe release notes.
Galil maintains an RSS page to notify users of updates.

See the update history of gcaps inthe release notes.

Technical Support

For help please email support@galil.com,orcall Galil Applications.


mailto:support@galil.com
mailto:support@galil.com
globals_func.html
http://www.galil.com/sw/pub/all/rn/gclib.html
http://www.galil.com/sw/pub/all/rss/gclib.xml
http://www.galil.com/sw/pub/all/rn/gcaps.html
mailto:support@galil.com
http://www.galil.com/contact

Getting Started

gclib 1.31.6



Chapter 2

Example Projects

Description

Welcome to gclib Example Projects. The Galil Communication Library (gclib) is a communication library for Galil
motion controllers and PLCs. A number of programming languages, operating systems, and hardware platforms
are supported.

These in-depth examples will demonstrate how to use the basics of gclib such as connecting to the controller and
issuing commands, as well as more advanced topics such as assigning a controller an IP Address and monitoring
interrupts.

Projects
Example Description
Commands Example Demonstrates various uses of GCommand() and GUTHility().
Message Example Demonstrates how to receive messages from the controller and detect differences

in Trace and crashed code.
Position Tracking Example | Puts controller into Position Tracking Mode and accepts user-entered positions.

Jog Example Puts controller into Jog Mode and accepts user input to adjust the speed.
Vector Mode Example Puts controller into Vector Mode and accepts a file defining vector points.
IP Assigner Example Assigns controller an IP Adress given a serial number and a 1 byte address.

Motion Complete Example | Uses interrupts to track when the motion of controller is completed.

Record Position Example Record user's training and saves to a text file.
Contour Example Record user's training and plays back training through contour mode.
Remote Server Example Advertise local gcaps server on the network.

Remote Client Example Discover and connect to other gcaps servers on the network.

Instructions

For build instructions, please select a supported language:

* C/C++
« C#.NET
« VB.NET

We are always interested in what our customers would like to see! To request any new examples or supported
languages, please email support@galil.com.


mailto:support@galil.com

Example Projects

2.1 Commands Example

C++

C#

Visual Basic

Example Example Example
Logic Logic Logic
Instructions | Instructions Instructions

We are always interested in what our customers would like to see! To request any new examples or supported
languages, please email support@galil.com.

Concepts

This example demonstrates:

* How to connect to a controller via IP Address.

* How to issue basic commands.

« How to read data back from the controller.

» How to get context on errors that occur in the program.

Prerequisites

A Galil controller is required for this example.

Command Line Arguments
This example requires 1 argument:
» The IP Address of a Galil controller.

commands_example.exe 192.168.42.200

Example Output

Nk k ok hkkhh kA hhk kA A Ak kA kA h kA A Ak kA A Ak A A KAk A A Ak kA KAk A A Kk kA A Ak kA KA kA A Kk kA KAk Ak Kk kA kKK

Nk sk ok ok ok ok Kk kK kK kK ok ok ok K ok Kk kK kK GCmdT () example

R R R

B R R

GCmdT () will return a trimmed response of GCommand ()
The command ’'PR ?,7?’ will return the relative position of the A and B axes

«PR ?,? with GCommand() : 0, 10000
D
«PR ?,? with GCmdT(): 0, 10000»

Yokkkkkkkhkhkhkkhkkhkkkkkkkkkhkhkhkhkhkkhkkhkkhkkkkkhkhkhkkkkkkkkkhkkkkkhkkhkkkkkkkkkkk**

Nk Kk ok kK ok ok ok ok Kk ok Kk ok Kk ok Kk ok ok ok kK ok Kk kK GCmdI () example

Yok ok kA kA Ak kA h kA Ak kA A kA A A kA Ak A A Ak kA A kA Ak kA Ak kA Ak kA kA Ak kA Ak h kA hk kA hk Ak hkkxk
GCmdI () will return the value of GCommand() parsed as an int
The command 'MG _IMS’ will return the available space in the vector buffer of the S plane.

MG _LMS with GCmdT(): 511.0000
MG _LMS with GCmdI(): 511

B R R R R R R ]

Nk kok ok ok ok Kok ok ok Kk ok ok ok Kk ok ok ok Kk ok ok K K GCmd () example

Ykkkkkhkhkhkhkhkkhkhhkkhkkhkhhhhhkhkhkhhhkkhkkhkkkkhkhkhkhkkkkkhkkhkkhkkhkhkhkkhkkk Kk kkk**

Kk kkkkhkkhkkkkkkkkhkkkkkkkkkkkkx

R R

GCmd () will execute the given command but does not return a value.

GCmd is useful for basic operations such as beginning motion or setting speed

GCmd (g, "BG A");
GCmd (g, "SP 5000");

Ykkkkkkkhkhkhkhkkhkkkkkkkkkhkhkhkhkhkkhkhhkkhkkkkkhkhkhkhkkkkkhkkhkkhkhkkhkhkhkkkkkkkkk**

Nk Kok Kk ok kK Kk ok Kk ok Kk ok Kk ok Kk ok ok K ok Kk Kk kK GCmdD () example

Yok ok ko kA Ak kA hhhk Ak h kA Ak kA A kA Ak h kA h kA Ak A Ak kA Ak hhk Ak h kA kA Ak hk kA hhkkkhhkkkhkkxhkkx Kk
GCmdD () will return the value of GCommand parsed as a double

Kk kkhkkhkkhkkkkkkkkhkkkhkkhkkhkkkkkx

The command 'MG @AN[1]’ will return the value of Analog Input 1

MG @AN[1] with GCmdD(): 9.7726

gclib 1.31.6
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Nk sk ok ok ok ok K ok ok ok ok ok ok ok ok K ok ok K ok kK ok kK ok ok K ok ok ok ok ko ok kK ok ko ok ko ok Kk ok X o ok K ok ok ok ok ok K o ok K ok ok ok ok ok ok ok kK ok ok Kk ok ok kY
Vhkkkkkkkhkkkkhkk Ak khkhk kK Kk kk* Galil Double Format Kk kkhkkkkkhkkkhkkkkhkkkkkxk

Nk Sk sk ok ook ok ok ok Kk k k ok k ok ke k kK K Kk ks ok sk sk sk ok sk ok ok sk ok k ok k ke ke k kK ok K ok ok ok sk ok ok ok sk sk ok ok ok k ok k ok ok kK K K K ok ok ok ok ok ok ok ok ok ok Y
Galil Controllers expect double values to be formatted to 4 decimal places
Unformatted double value: 0.00235

Formatted double value rounded to 4 decimal places: 0.0024

R R s R R R R R R R R R R R R R R R R R R R R R R R R R R RIS

Nk ok ok ok ok Kok ok ok ok ok ok ok ok ok K K K G_UTIL_ERROR_CONTEXT example KAk KAk kkkkkkkkkkkkkkkkkx ©
Nokkk ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok kkk kA kA kAR ARk kkkkhhkhkkkkkkkkkkkkkkkkkk ok ok k ok kkk kA A kXA XAk Ak kk

GUtility () with G_UTIL_ERROR_CONTEXT: Broken Pipe

2.2 Message Example

C++ Cit Visual Basic
Example Example Example
Logic Logic Logic
Instructions | Instructions Instructions

We are always interested in what our customers would like to see! To request any new examples or supported
languages, please email support@galil.com.

Concepts
This example demonstrates:

» How to connect to a controller via IP Address.

+ How to issue basic commands.

» How to reconstitute a full message from GMessage().

» How to detect differences in crashed DMC code and Trace.
» How to print messages.

» How to use Keep Alive to maintain connection to gcaps.

Prerequisites

A Galil controller with a motor connected at the A axis is needed for this example.

Command Line Arguments
This example requires 1 argument:

« The IP Address of a Galil controller.

message_example.exe 192.168.42.96

Example Output

Vokkkkkkkhkhkhkhhkhhkkkkkkkkkhkkkkkkkkkhkkhhkhkhkhkkhkkkkkkkkkkkhkhkkkkkhkkkkkkkx ©

Example GMessage () usage

Nk khkkkkhhhkhhkhkkhhk kA khhkkhhk kA khhkk kA khkhkkhhk kA khhkkkkhk kA khhk kA khkkk Kk kk k& Kk x kKK
<HELLO WORLD

>

Trace Line: 0 1i=0

Trace Line: 1 #A

Trace Line: 2 MGi

Standard Line: 0.0000

\

gclib 1.31.6
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6

Trace Line: 3 i=i+l
Trace Line: 4 WT100
Trace Line: 5 JP#A,i<1
Trace Line: 6 i=1i/0

Crashed Code: 2?6 i=1i/0

2.3 Position Tracking Example

C++ Cit Visual Basic
Example Example Example
Logic Logic Logic
Instructions | Instructions Instructions

We are always interested in what our customers would like to see! To request any new examples or supported

languages, please email support@galil.com.

Concepts
This example demonstrates:

* How to connect to a controller via IP Address.
* How to issue basic commands.

+ A controller in position tracking mode.

Prerequisites

A Galil controller with a motor connected at the A axis is needed for this example.

Command Line Arguments
This example has 1 required argument and 1 optional argument:

» Required: The IP Address of a Galil controller.

+ Optional: The speed of the controller in Position Tracking mode (Default 5000).

position_tracking_example.exe 192.168.42.96 4000

Example Output

Begin Position Tracking with speed 5000. Enter a non-number to exit.

Enter a new position:
4000
Enter a new position:
-8000
Enter a new position:
10000
Enter a new position:

2.4 Jog Example

C++ C#

Visual Basic

Example Example

Example

gclib 1.31.6
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C++ C# Visual Basic
Logic Logic Logic
Instructions | Instructions Instructions

We are always interested in what our customers would like to see! To request any new examples or supported
languages, please email support@galil.com.

Concepts
This example demonstrates:

* How to connect to a controller via IP Address.
* How to issue basic commands.
« A controller in jogging mode.

» How to utilize keyboard input at the console.

Prerequisites
A Galil controller with a motor connected at the A axis is needed for this example.

Note

Linux users will need to install the ncurses library.

Command Line Arguments
This example requires 1 argument:

« The IP Address of a Galil controller.

jog_example.exe 192.168.42.96

Example Output

Enter a character on the keyboard to change the motor’s speed:
<g> Quit

<a> -2000 counts/s

<s> -500 counts/s

<d> +500 counts/s

<f> +2000 counts/s

<r> Direction Reversal
Jog Speed: 0

Jog Speed: 2000

Jog Speed: 4000

Jog Speed: 6000

Jog Speed: —-6000

Jog Speed: -8000

Jog Speed: -6000

2.5 Vector Mode Example

C++ C# Visual Basic
Example Example Example
Logic Logic Logic
Instructions | Instructions Instructions

gclib 1.31.6


mailto:support@galil.com

Example Projects

We are always interested in what our customers would like to see! To request any new examples or supported

languages, please email support@galil.com.

Concepts
This example demonstrates:

* How to connect to a controller via IP Address.
* How to issue basic commands.

« A controller in vector mode.

» How to read and maintain the length of the vector buffer.

» How to read in a file of vector points and apply them to the controller.

Prerequisites

A Galil controller with two motors: one connected at the A axis and the other connected at the B axis.

Command Line Arguments
This example requires 2 arguments:

« The IP Address of a Galil controller.

» The path to a file containing vector commands.

vector_example.exe 192.168.42.92 vector_points.txt

2.6 IP Assigner Example

C++ Cit Visual Basic
Example Example Example
Logic Logic Logic
Instructions | Instructions Instructions

We are always interested in what our customers would like to see! To request any new examples or supported

languages, please email support@galil.com.

Concepts

This example demonstrates:

» How to issue basic commands.

+ How to listen on the network for Galil Controllers requesting an IP Address.

» How to assign a Galil Controller an IP Address.

« How to connect to a controller via IP Address.

» How to get information on a connected controller such as MAC Address and Serial Number.

gclib 1.31.6
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2.7 Motion Complete Example

Prerequisites

A Galil controller connected to the same network as the host computer.

Command Line Arguments

This example requires 2 arguments:

» The serial number of your controller. The value to use is the number after the prefix on the controller's serial
number marking. For example, if the serial number is marked as BV-1234, the value to use for this argument

is 1234.

A value between 1-254 that defines the last byte of the newly assigned IP Address. This example will assign
an |IP address that matches your computer's IP address, with the last byte changed. For example, if your IP
address is 192.168.42.92 and 96 is specified, the controller will be assigned 192.168.42.96. The example will

ping the IP address to ensure that the IP address is not already taken.

ip_assigner_example.exe 1234 96

2.7 Motion Complete Example

C++ Cit Visual Basic
Example Example Example
Logic Logic Logic
Instructions | Instructions Instructions

We are always interested in what our customers would like to see! To request any new examples or supported

languages, please email support@galil.com.

Concepts

This example demonstrates:
* How to connect to a controller via IP Address.
* How to issue basic commands.

» How to move the controller to a precise position.

» How to monitor the interrupts of the controller.

Prerequisites

A Galil controller with two motors: one connected at the A axis and the other connected at the B axis.

Command Line Arguments
This example requires 1 argument:

« The IP Address of a Galil controller.

motion_complete_example.exe 192.168.42.96

gclib 1.31.6
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Example Output

Ykkkkkhkhkhkhhhkhhkhhkkhkkkhkhkhkhkhkhkkhkkhkkhkkkhkhkhkhkkkkkkkkkkkkk ©

Example GInterrupt ()

Vokkkkkkkkkkkhkkhkkhkkkkkkkkkkkhkhkhkkhkkhkkhkkhkkkkkkkkkhkkkkkkkkkkkkx ©

Position: 0, O,

Beginning independent motion...
Motion Complete on A and B

Position: 8000,

0, 0

2.8 Record Position Example

C++ C# Visual Basic
Example Example Example
Logic Logic Logic

Instructions

Instructions

Instructions

We are always interested in what our customers would like to see! To request any new examples or supported

languages, please email

Concepts

This example demonstrates:

support@galil.com.

* How to connect to a controller via IP Address.

* How to issue basic commands.

» How to manage a record array (RC/RD/RA) ring buffer.

» How to record position data and save to a text file.

Prerequisites

A Galil controller with a motor connected at the A axis and B axis is needed for this example.

Command Line Arguments

This example requires 3 arguments:

« The IP Address of a Galil controller.

» The path to a file to save Axis A positional data.

» The path to a file to save Axis B positional data.

record_position_example.exe 192.168.42.96 axis_a.csv axis_b.csv

2.9 Contour Example

C++ Cit Visual Basic
Example Example Example
Logic Logic Logic
Instructions | Instructions Instructions

gclib 1.31.6
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We are always interested in what our customers would like to see! To request any new examples or supported
languages, please email support@galil.com.

Concepts
This example demonstrates:

» How to connect to a controller via IP Address.
* How to issue basic commands.
» How to record position data and save to a text file.

» How to play back recorded data using contour mode.

Prerequisites

A Galil controller with a motor connected at the A axis and the B axis is needed for this example.

Command Line Arguments
This example requires 3 arguments:

« The IP Address of a Galil controller.
» The path to a csv file to store positional data for the A axis.

» The path to a csv file to store positional data for the B axis.

contour_example.exe 192.168.42.200 axis_a.csv axis_b.csv

2.10 Remote Server Example

C++ C# Visual Basic
Example Example Example
Logic Logic Logic
Instructions | Instructions Instructions

We are always interested in what our customers would like to see! To request any new examples or supported
languages, please email support@galil.com.

Concepts
This example demonstrates:

» How to advertise your gcaps server on the network for others to discover

Prerequisites

This example works best in conjunction with the Remote Client Example running on a separate machine on the
same network.

gclib 1.31.6
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Note

Linux users will need to install the ncurses library.

2.11 Remote Client Example

C++ C# Visual Basic
Example Example Example
Logic Logic Logic
Instructions | Instructions Instructions

We are always interested in what our customers would like to see! To request any new examples or supported

languages, please email

Concepts

This example demonstrates:

» How to discover other gcaps servers on your local network

+ How to connect to other gcaps servers

» How to list available hardware on your connected server

Prerequisites

support@galil.com.

This example works best in conjunction with the Remote Server Example running on a separate machine on the

same network.

Note

Linux users will need to install the ncurses library.

Example Output

Text colored green represents user input.
<s> List available servers on the network
<h> List available hardware on currently connected server
<0-9> Enter numbers 0-9 to connect to a server by index
<1> Set active server back to local server

<g> Quit

h

192.168.42.28, DMC4080 Rev 1.3c,

COM1
COM3
CcoM4

S

Available Servers:
<0> Example Server

0

Server set to:

h
/dev/ttySO0
/dev/ttyUSBO

Server set to:

Example Server

Local

Controller,

192.168.42.1

gclib 1.31.6
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212 C/C++

Please choose an operating system to get detailed instructions on how to build the gclib example projects.

* Microsoft Windows

e Linux

2.12.1 Microsoft Windows

Copy files

» Navigate to a convenient, empty, writable location, e.g. C:\Users\{username}\Documents\Galil\cpp_«-
examples.

« Copy the contents of C:\Program Files (x86)\Galil\gclib\examples\cpp\examples to this location.

Open Visual Studio Project

The following instructions were performed on Visual Studio Professional 2017 and Visual Studio Professional 2019
and can be extended to other Visual Studio versions. For brevity, the instructions assume the default installation
location of C:\Program Files (x86)\Galil\gclib and a build type of x64.

+ Launch Visual Studio 2017 or Visual Studio 2019.

+ Choose File->Open-> Project/Solution....

» Navigate to the examples.vcxproj file in the C:\Users\{username}\Documents\Galil\cpp_examples directory.
+ Click Open.

* In the Solution Explorer right-click on the examples project file, choose Properties.

— Click the Configuration Manager... button.

= Under Active solution platform: choose x64.
= Click Close.

— Highlight Configuration Properties in the side bar, and set the following project properties.

= Configuration Properties -> Debugging -> Environment add PATH=C:\Program Files
(x86)\Galil\gclib\dIl\x64;%PATH%

= Click OK.

» Many of the examples require command line arguments to execute. To enter command line arguments in
Visual Studio:

— In the Solution Explorer right-click on the examples project file, choose Properties.

= Under Configuration Properties, highlight Debugging in the side bar. Enter the appropriate argu-
ments in the Command Arguments box. Refer to each example's landing page for required com-
mand line arguments.

» Ensure the Solution Configurations and Solution Platforms are set to Debug and x64 respectively.

+ Hit F5to build and run the example.

gclib 1.31.6
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Run a Different Example

To run a different example, remove the current example from the solution and add the next example.

« In the Solution Explorer right-click on commands_example.cpp, choose Remove.

— Click the Remove button.

« In the Solution Explorer right-click on the examples project file, choose Add->Existing Iltem.

— Navigate to the desired example file and click Add.

« Hit F5to build and run the example.

2.12.2 Linux

Copy examples to a temporary directory

Create temporary directory:
mkdir ~/temp

Copy examples to ~/temp
cp /usr/share/doc/gclib/src/gclib_example_projects.tar.gz ~/temp

Navigate to ~/temp
cd ~/temp

Extract the examples with command:

tar -xzf gclib_example_projects.tar.gz

Run Make

To build all examples:

make

To build a single example:

make commands.o

To run an example:

./commands_example.out

2.13 C#.NET

Open Visual Studio Project

The following instructions were performed on Visual Studio Professional 2017 and can be extended to other Vi-
sual Studio versions. For brevity, the instructions assume the default installation location of C:\Program Files

(x86)\Galil\gclib and a build type of x64.

Copy files

» Navigate to a convenient, empty, writable location, e.g. C:\Users\{username}\Documents\Galil\cs_«-

examples.

« Copy the contents of C:\Program Files (x86)\Galil\gclib\examples\cs\examples to this location.

gclib 1.31.6
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Configure Project

+ Launch Visual Studio 2017.

+ Choose File->Open-> Project/Solution....

» Navigate to the examples.sin file in the C:\Users\{username}\Documents\Galil\cs_examples directory.
« Click Open.

* In the Solution Explorer right-click on the examples project file, choose Properties.

— Click the Build tab.

= At the top of the window next to Platform choose x64.
= Click Save.
= Close the properties window.

— In the Solution Explorer right-click on the examples project file, choose Add-> Existing Item.

= Navigate to the gclib C# wrapper at location C:\Program Files (x86)\Galil\gclib\source\wrappers\cs
and select gclib.cs.

« Click OK.

* Many of the examples require command line arguments to execute. To enter command line arguments in
Visual Studio:

— In the Solution Explorer right-click on the examples project file, choose Properties.

= Under Debug, enter the appropriate arguments in the Command line arguments box. Refer to each
example's landing page for required command line arguments.

» Ensure the Solution Configurations and Solution Platforms are set to Debug and x64 respectively.

+ Hit F5to build and run the example.

Run a Different Example
To run a different example, change the Startup object to the new example.

 In the Solution Explorer right-click on the examples project file, choose Properties.

— Click the Application tab.
= Under the Startup object dropdown, select a different example.
— Click the Debug tab.
= Enter the appropriate arguments in the Command line arguments box. Refer to each
example's landing page for required command line arguments.

+ Hit F5to build and run the example.

2.14 VB.NET

Open Visual Studio Project

The following instructions were performed on Visual Studio Professional 2017 and can be extended to other Vi-
sual Studio versions. For brevity, the instructions assume the default installation location of C:\Program Files
(x86)\Galil\gclib and a build type of x64.
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Copy files

» Navigate to a convenient, empty, writable location, e.g. C:\Users\{username}\Documents\Galil\vb_«-
examples.

» Copy the contents of C:\Program Files (x86)\Galil\gclib\examples\vb\examples to this location.

Configure Project

» Launch Visual Studio 2017.

» Choose File->QOpen->Project/Solution....

» Navigate to the examples.sin file in the C:\Users\{username}\Documents\Galil\vb_examples directory.
+ Click Open.

* In the Solution Explorer right-click on the examples project file, choose Properties.

— Click the Compile tab.
= At the top of the window next to Platform choose x64.
= Close the properties window.
— In the Solution Explorer right-click on the examples project file, choose Add-> Existing Item.

= Navigate to the gclib VB wrapper at location C:\Program Files (x86)\Galil\gclib\source\wrappers\vb
and select gclib.vb.

= Click OK.

* Many of the examples require command line arguments to execute. To enter command line arguments in
Visual Studio:

— In the Solution Explorer right-click on the examples project file, choose Properties.

= Under Debug, enter the appropriate arguments in the Command line Arguments box. Refer to each
example's landing page for required command line arguments.

» Ensure the Solution Configurations and Solution Platforms are set to Debug and x64 respectively.

« Hit F5to build and run the example.

Run a Different Example
To run a different example, change the Startup object to the new example.

 In the Solution Explorer right-click on the examples project file, choose Properties.

— Click the Application tab.
= Under the Startup object dropdown, select a different example.
— Click the Debug tab.
= Enter the appropriate arguments in the Command line arguments box. Refer to each
example's landing page for required command line arguments.

+ Hit F5to build and run the example.
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Chapter 3

Installation

Supported Operating Systems

» Most versions are 64 bit (x64). A 32 bit (x86) version of gclib is also available on Windows.

+ Older operating systems are listed along with the last Galil builds. On Linux, install these packages in this
order gclib -> gcapsd -> GDK.

Microsoft Windows

10

8.1, No Galil Connect

Older Versions gclib gcaps GDK

7 245.331.480 1.0.0.151 1.0.24.655
Ubuntu

20.04

18.04

Older Versions gclib gcaps GDK

16.04 200.252.396 1.0.0.130 1.0.7.353
14.04 189.224.370

12.04 130.114.278

Red Hat and CentOS
Red Hat 8 & CentOS 8 Linux
Red Hat 7 & CentOS 7 Linux

Older Versions gclib gcaps GDK

Red Hat 6 & CentOS 6 Linux 147.185.319

Fedora

32

31

Older Versions gclib gcaps GDK

30 267.339.528 1.0.0.210 1.0.25.696
29 239.316.448 1.0.0.149 1.0.18.601
28 222.301.423 1.0.0.143 1.0.13.526
27 200.252.396 1.0.0.130 1.0.7.353
26 195.232.387 1.0.0.128 1.0.5.307
25 194.232.386 1.0.0.128 1.0.5.305
24 189.224.370 1.0.0.124 1.0.4.276
23 154.190.329 1.0.0.68

22 130.114.278

21 130.114.278

Raspberry Pi



https://www.galil.com/sw/pub/win/gclib/galil_gclib_480.exe
https://www.galil.com/sw/pub/win/gcaps/galil_gcaps_151.exe
https://www.galil.com/sw/pub/win/gdk/galil_gdk_655.exe
https://www.galil.com/sw/pub/ubuntu/16.04/pool/non-free/g/gclib/gclib_396-1_amd64.deb
https://www.galil.com/sw/pub/ubuntu/16.04/pool/non-free/g/gcapsd/gcapsd_130-1_amd64.deb
https://www.galil.com/sw/pub/ubuntu/16.04/pool/non-free/g/gdk/gdk_1.0.7.353-1_amd64.deb
https://www.galil.com/sw/pub/ubuntu/14.04/pool/non-free/g/gclib/gclib_370-1_amd64.deb
https://www.galil.com/sw/pub/ubuntu/12.04/pool/non-free/g/gclib/gclib_278-1_amd64.deb
https://www.galil.com/sw/pub/rhel/6/x86_64/gclib/gclib-319-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/30/x86_64/gclib/gclib-528-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/30/x86_64/gcapsd/gcapsd-210-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/30/x86_64/gdk/gdk-1.0.25.696-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/29/x86_64/gclib/gclib-448-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/29/x86_64/gcapsd/gcapsd-149-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/29/x86_64/gdk/gdk-1.0.18.601-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/28/x86_64/gclib/gclib-423-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/28/x86_64/gcapsd/gcapsd-143-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/28/x86_64/gdk/gdk-1.0.13.526-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/27/x86_64/gclib/gclib-396-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/27/x86_64/gcapsd/gcapsd-130-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/27/x86_64/gdk/gdk-1.0.7.353-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/26/x86_64/gclib/gclib-387-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/26/x86_64/gcapsd/gcapsd-128-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/26/x86_64/gdk/gdk-1.0.5.307-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/25/x86_64/gclib/gclib-386-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/25/x86_64/gcapsd/gcapsd-128-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/25/x86_64/gdk/gdk-1.0.5.305-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/24/x86_64/gclib/gclib-370-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/24/x86_64/gcapsd/gcapsd-124-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/24/x86_64/gdk/gdk-1.0.4.276-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/23/x86_64/gclib/gclib-329-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/23/x86_64/gcapsd/gcapsd-68-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/22/x86_64/gclib/gclib-278-1.x86_64.rpm
https://www.galil.com/sw/pub/fedora/21/x86_64/gclib/gclib-278-1.x86_64.rpm
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Microsoft Windows
Buster, Raspberry Pi 4
Stretch, Raspberry Pi 3+

Older Versions gclib gcaps GDK
Jessie, Raspberry Pi 2 194.232.386

Apple

Older Versions gclib gcaps GDK
Yosemite 189.220.368

3.1 Microsoft Windows

Tested versions

See the installation page for supported versions.

Install
On Windows, gclib is distributed in the following formats.

» An executable installer which will install the library in the proper location to work with the included examples
and documentation. PCl users can optionally install the PCI driver from within this installer.

+ A zip file containing the same set of files as the executable but in a zip archive. PCI users can use the
stand-alone PCI driver installer.

— A stand-alone PCI driver installer for PCI users (DMC-1806, 1800, 1802, 1417).

Note

The PCI driver is compatible with GalilTools but is enhanced for gclib/GDK communications.

Download Installer

Recommended. All instructions and examples depend on the installation paths.

Download Zip

For custom deployment or non-default file locations. Downloads are available onthe release notes page.

Required third-party DLLs

gclib is built using MSVC 2017 and requires run-time components available in the Microsoft Visual C++
Redistributable for Visual Studio 2017

The gclib installer will automatically install these prerequisites for both 32 bit (x86) and 64 bit (x64) builds.

If using the zip installation, the binaries must be downloaded and installed manually.

Silent Installation

For developers wishing to bundle gclib within their own installers, execute the gclib installer with the /S switch to
run silently with defaults. If the Galil security certificate is not already trusted on the deployment target, a digital
signature dialog may be presented.

Uninstall

Rununinstall.exe in "C:\Program Files (x86)\Galil\gclib"
Alternatively, the Add or remove programs Control Panel can be used to remove all Galil software by product.
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https://www.galil.com/sw/pub/raspbian/8.0/pool/non-free/g/gclib/gclib_386-1_armhf.deb
https://www.galil.com/sw/pub/apple/osx/10.10/gclib/gclib.368.dmg
http://www.galil.com/sw/pub/all/rn/gclib.html
https://support.microsoft.com/en-us/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-us/help/2977003/the-latest-supported-visual-c-downloads

3.2 Ubuntu Linux 19

Upgrading and Older Versions

The release notes page lists all available versions of gclib. Galil recommends uninstalling any current version of
gclib before installing other versions.

Installed Directories

The installation is organized into several directories.

dil

The dll directory contains the binary dynamic link libraries (DLLs) for x86 and/or x64 architectures. Dynamically
linked executables must have the correct dlls in their path at runtime.

doc

The doc directory contains this documentation and a printable, pdf version.

examples

The examples directory contains example projects for various compilers. The cpp directory contains x_examples.h
and the implementation of the example files documented in this manual.

Warning
Before using the examples, copy the files to a user location such as C:\Users\user\Documents. Failing to do
s0 may cause source files to be deleted upon gclib uninstallation.

include

The include directory contains header files needed for compiling code. The compiler will need to know where these
files are at compile time.
See the compiler-specific directions for more information, e.g. mingw.

lib

The lib directory contains linker files (gclib.lib and gclibo.lib) for x86 and/or x64 architectures. The linker should
include gclib.lib and gclibo.lib.

source

The source directory contains source files such as gclibo.c.

3.2 Ubuntu Linux

Tested versions

See the installation page for supported versions.

Installation
Note

Adding the package repository is a prerequisite to continue.

Install

Install gclib and gcapsd (recommended)

# apt install gclib gcapsd

gclib 1.31.6


http://galil.com/sw/pub/all/doc/global/html/repositories.html

20 Installation

Uninstall

If gclib is to be removed from the system, the following commands may be used.

# apt remove gclib gcapsd

Upgrading
To upgrade gclib to the newest release, use the following command.

# apt install —--only-upgrade gclib gcapsd

List All Versions

Galil keeps older versions of gclib and gcapsd available for users. To list all versions use the following command.

$ apt-cache madison gclib gcapsd

Installing Older Versions

Warning

When using gcaps, a compatible pairing of gcaps and gclib must be used. Galil maintains this compatibility
with installations and upgrades. Installing GDK will also install compatible versions of gclib and gcaps. When
installing older versions manually, it is the user's responsibility to ensure compatible versions.

Append the desired version's information after the package name.

# apt install gclib=<version> gcapsd=<version>

An Example

On the developer's machine, gclib is installed with the current version.
$ sudo apt install gclib gcapsd

After installation, the versions can be queried.

$ apt list --installed gclib gcapsd

Listing... Done

gcapsd/unknown, now 205-1 amd64 [installed]
gclib/unknown,now 517-1 amdé64 [installed]

On the deployment machine, the precise versions can now be specified.

$ sudo apt install gclib=517-1 gcapsd=205-1

Serial Ports and USB

If access to the serial ports or USB (e.g. DMC-4103) is desired through gclib, the following will provide steps to
join the correct access group. If using USB, be sure the controller is powered and the usb is plugged in before
beginning.

Determine group with access

$ 1s -1 /dev/ttyUSBx /dev/ttySx

crw-rw—-—--—. 1 root dialout 4, 64 Mar 3 16:39 /dev/ttySO
crw-rw-——-—. 1 root dialout 4, 65 Mar 3 16:39 /dev/ttySl
crw-rw—-——-. 1 root dialout 4, 66 Mar 3 16:39 /dev/ttyS2
crw-rw——-—. 1 root dialout 4, 67 Mar 3 16:39 /dev/ttyS3
crw-rw-——-. 1 root dialout 188, 0 Mar 6 11:08 /dev/ttyUSBO

In the above listing, dialout is the group that needs to be joined. uucp is another common group that may be listed.
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Add the desired username to the group.

$ sudo gpasswd -a username dialout
[sudo] password for username:
Adding user username to group dialout

Log out and back in for change to take effect.

$ groups
username wheel dialout

gclib can now connect to serial and usb devices from user username.

PCI Controllers

If using a Galil PCI controller, the PCI driver must be installed.

Extract source and build driver

$ tar -xf /usr/share/doc/gclib/src/gclib_pci.tar.gz
$ make

Copy module and add to kernel

$ sudo cp galilpci.ko /lib/modules/$ (uname -r)
$ sudo depmod
$ sudo modprobe galilpci

Add galil group for access to PCI

sudo groupadd -f -K GID_MIN=100 -K GID_MAX=499 galil

sudo cp 90-galilpci.rules /etc/udev/rules.d/

sudo udevadm control --reload-rules

sudo udevadm trigger

sudo usermod -a -G galil username #exchange "username" with actual user’s name

O W U A

Logout and back in. The PCI hardware is now available for access.

$ 1s -1 /dev/galil«

crw-rw-—-- 1 root galil 10, 56 Jun 9 11:07 /dev/galilpciO
$ echo -e "\x12\xlé6\r" > /dev/galilpciO

$ cat /dev/galilpciO

DMC1846 Rev 1.la

Documentation

The documentation is left as a tarball to minimize disk usage. The latest release version of the user manual is
available at the following link.

e http://www.galil.com/sw/pub/all/doc/gclib/html/

Offline html
The following allows viewing of the html docs from the installation.

$ tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz html
$ firefox html/index.html

3.3 Red Hat 8 & CentOS 8 Linux

Tested versions

See the installation page for supported versions.
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Installation
Note

Adding the package repository is a prerequisite to continue.

Install

Install gclib and gcapsd (recommended)

# dnf install gclib gcapsd

Approve Installed size and Importing GPG key, if prompted.

Uninstall

If gclib is to be removed from the system, the following commands may be used.

# dnf remove gclib gcapsd

Upgrading
To upgrade gclib to the newest release, use the following command.

# dnf upgrade gclib gcapsd

List All Versions

Galil keeps older versions of gclib and gcapsd available for users. To list all versions use the following command.

$ dnf list gclib gcapsd —--showduplicates

Installing Older Versions

Warning

When using gcaps, a compatible pairing of gcaps and gclib must be used. Galil maintains this compatibility
with installations and upgrades. Installing GDK will also install compatible versions of gclib and gcaps. When
installing older versions manually, it is the user's responsibility to ensure compatible versions.

Append the desired version's information after the package name.

# dnf install gclib-<version> gcapsd-<version>

An Example

On the developer's machine, gclib is installed with the current version.

$ sudo dnf install gclib gcapsd

After installation, the versions can be queried.

$ dnf list gclib gcapsd —--installed

Installed Packages

gcapsd.x86_64 194-1 @galil
gclib.x86_64 506-1 @galil
On the deployment machine, the precise versions can now be specified.

$ sudo dnf install gclib-506-1 gcapsd-194-1

Serial Ports and USB

If access to the serial ports or USB (e.g. DMC-4103) is desired through gclib, the following will provide steps to
join the correct access group. If using USB, be sure the controller is powered and the usb is plugged in before
beginning.
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Determine group with access

$ 1s -1 /dev/ttyUSB* /dev/ttyS=*

crw-rw———-. 1 root dialout 4, 64 Mar 3 16:39 /dev/ttySoO
crw-rw-———. 1 root dialout 4, 65 Mar 3 16:39 /dev/ttySl
crw-rw—-—---—. 1 root dialout 4, 66 Mar 3 16:39 /dev/ttyS2
crw-rw-——-—. 1 root dialout 4, 67 Mar 3 16:39 /dev/ttyS3
crw-rw-——-. 1 root dialout 188, 0 Mar 6 11:08 /dev/ttyUSBO

In the above listing, dialout is the group that needs to be joined. uucp is another common group that may be listed.

Add the desired username to the group.

$ sudo gpasswd —a username dialout
[sudo] password for username:
Adding user username to group dialout

Log out and back in for change to take effect.

$ groups
username wheel dialout

gclib can now connect to serial and usb devices from user username.

PCI Controllers

If using a Galil PCI controller, the PCI driver must be installed.

Install prerequisites

# dnf update kernel

Reboot

# dnf install kernel-devel-S$ (uname -r)
# dnf install kernel-headers-$ (uname -r)
# dnf install gcc

Extract source and build driver

$ tar -xf /usr/share/doc/gclib/src/gclib_pci.tar.gz
$ make

Copy module and add to kernel

# cp galilpci.ko /lib/modules/$ (uname -r)
# depmod
# modprobe galilpci

Add galil group for access to PCI

groupadd —-f -K GID_MIN=100 -K GID_MAX=499 galil

cp 90-galilpci.rules /etc/udev/rules.d/

udevadm control --reload-rules

udevadm trigger

usermod -a -G galil username #exchange "username" with actual user’s name

HH = H W

Logout and back in. The PCI hardware is now available for access.

$ 1s -1 /dev/galil«

crw-rw-——-— 1 root galil 10, 56 Jun 9 11:07 /dev/galilpciO
$ echo -e "\x12\x1l6\r" > /dev/galilpciO

$ cat /dev/galilpciO

DMC1846 Rev 1l.la
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Documentation

The documentation is left as a tarball to minimize disk usage. The latest release version of the user manual is
available at the following link.

e http://www.galil.com/sw/pub/all/doc/gclib/html/

Offline html
The following allows viewing of the html docs from the installation.

$ tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz html
$ firefox html/index.html

3.4 Red Hat 7 & CentOS 7 Linux

Tested versions

See the installation page for supported versions.

Installation
Note

Adding the package repository is a prerequisite to continue.

Install
Install gclib and gcapsd (recommended)

# yum install gclib gcapsd

Approve Installed size and Importing GPG key, if prompted.

Uninstall
If gclib is to be removed from the system, the following commands may be used.

# yum remove gclib gcapsd

Upgrading
To upgrade gclib to the newest release, use the following command.

# yum upgrade gclib gcapsd

List All Versions
Galil keeps older versions of gclib and gcapsd available for users. To list all versions use the following command.

$ yum list gclib gcapsd --showduplicates

Installing Older Versions

Warning

When using gcaps, a compatible pairing of gcaps and gclib must be used. Galil maintains this compatibility
with installations and upgrades. Installing GDK will also install compatible versions of gclib and gcaps. When
installing older versions manually, it is the user's responsibility to ensure compatible versions.

Append the desired version's information after the package name.

# yum install gclib-<version> gcapsd-<version>
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An Example

On the developer's machine, gclib is installed with the current version.
# yum install gclib gcapsd

After installation, the versions can be queried.

$ yum list installed gclib gcapsd

Loaded plugins: fastestmirror, langpacks

Loading mirror speeds from cached hostfile

* base: centos-distro.lgservers.com

* epel: sjc.edge.kernel.org

* extras: mirror.shastacoe.net

* updates: mirrors.oit.uci.edu

Installed Packages

gcapsd.x86_64 194-1
gclib.x86_64 506-1

On the deployment machine, the precise versions can now be specified.

# yum install gclib-506-1 gcapsd-194-1

If a newer version was previously installed, downgrade with the following.

# yum downgrade gclib-506-1 gcapsd-194-1

Serial Ports and USB

If access to the serial ports or USB (e.g. DMC-4103) is desired through gclib, the following will provide steps to
join the correct access group. If using USB, be sure the controller is powered and the usb is plugged in before

beginning.

Determine group with access

$ 1s -1 /dev/ttyUSBx /dev/ttySx

crw—-rw————. 1 root dialout 4, 64 Mar 3 16:39 /dev/ttySsO
crw-rw———-—. 1 root dialout 4, 65 Mar 3 16:39 /dev/ttySl
crw-rw—-——-. 1 root dialout 4, 66 Mar 3 16:39 /dev/ttyS2
crw-rw—-—-—. 1 root dialout 4, 67 Mar 3 16:39 /dev/ttyS3
crw-rw-——-. 1 root dialout 188, 0 Mar 6 11:08 /dev/ttyUSBO

In the above listing, dialout is the group that needs to be joined. uucp is another common group that may be listed.

Add the desired username to the group.

$ sudo gpasswd —a username dialout
[sudo] password for username:
Adding user username to group dialout

Log out and back in for change to take effect.

$ groups
username wheel dialout

gclib can now connect to serial and usb devices from user username.

PCI Controllers

If using a Galil PCI controller, the PCI driver must be installed.

Install prerequisites

# yum update kernel

Reboot

# yum install kernel-devel-$ (uname -r)
# yum install kernel-headers-$ (uname -r)
# yum install gcc

gclib 1.31.6
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Extract source and build driver

$ tar -xf /usr/share/doc/gclib/src/gclib_pci.tar.gz
$ make

Copy module and add to kernel

# cp galilpci.ko /lib/modules/$ (uname -r)
# depmod
# modprobe galilpci

Add galil group for access to PCI

groupadd -f -K GID_MIN=100 -K GID_MAX=499 galil

cp 90-galilpci.rules /etc/udev/rules.d/

udevadm control --reload-rules

udevadm trigger

usermod -a -G galil username #exchange "username" with actual user’s name

H= o W o

Logout and back in. The PCI hardware is now available for access.

$ 1s -1 /dev/galil«

crw-rw---- 1 root galil 10, 56 Jun 9 11:07 /dev/galilpciO
$ echo -e "\x12\x16\r" > /dev/galilpciO

$ cat /dev/galilpciO

DMC1846 Rev 1l.la

Documentation

The documentation is left as a tarball to minimize disk usage. The latest release version of the user manual is
available at the following link.

* http://www.galil.com/sw/pub/all/doc/gclib/html/

Offline html

The following allows viewing of the html docs from the installation.

$ tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz html
S firefox html/index.html

3.5 Red Hat 6 & CentOS 6 Linux

Tested versions

This version of Linux has x64/AMD64 Support Only. Contact Galil if another version is required for an application.
See the installation page for supported versions.

Installation

On Red Hat, gclib is distributed in an RPM repository. The following steps can be performed to install gclib.

Download Galil's repository information

This step installs Galil's RPM repositories and only needs to be done once.
Pointabrowserat http://www.galil.com/sw/pub/rhel/6/galilrpm-2-1.noarch.rpmandin-
stall the rpm.

Install Package
Install gclib package, approve "Installed size" and "Importing GPG key", if prompted.

# yum install gclib
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Uninstall Package

To uninstall gclib.

# yum remove gclib

Serial Ports and USB

If access to the serial ports or USB (e.g. DMC-4103) is desired through gclib, the following will provide steps to
join the correct access group. If using USB, be sure the controller is powered and the usb is plugged in before

beginning.

Determine group with access

$ 1s -1 /dev/ttyUSB* /dev/ttyS=*

crw-rw————. 1
crw—rw——-——. 1
crw-rw——-—-—. 1
crw—rw——-——. 1
crw—rw————. 1

root
root
root
root
root

dialout 4,
dialout 4,
dialout 4,
dialout 4,
dialout 188,

64
65
66
67

Mar
Mar
Mar
Mar
Mar

oW w ww

16:

16

39 /dev/ttyS0

:39 /dev/ttySl
16:
16:
11:

39 /dev/ttySs2
39 /dev/ttyS3
08 /dev/ttyUSBO

In the above listing, dialout is the group that needs to be joined. uucp is another common group that may be listed.

Add the desired username to the group.

$ sudo gpasswd -a username dialout
[sudo] password for username:
Adding user username to group dialout

Log out and back in for change to take effect.

$ groups

username wheel dialout

gclib can now connect to serial and usb devices from user username.

PCI Controllers

If using a Galil PCI controller, the PCI driver must be installed.

Install prerequisites

# yum update kernel

Reboot

# yum install kernel-devel-$ (uname -r)

# yum install kernel-headers-$ (uname -r)

# yum install

gcc

Extract source and build driver

$ tar -xf /usr/share/doc/gclib/src/gclib_pci.tar.gz

$ make

Copy module and add to kernel

# cp galilpci.ko /lib/modules/$ (uname -r)

# depmod

# modprobe galilpci
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Add galil group for access to PCI

groupadd -f -K GID_MIN=100 -K GID_MAX=499 galil

cp 90-galilpci.rules /etc/udev/rules.d/

udevadm control --reload-rules

udevadm trigger

usermod -a -G galil username #exchange "username" with actual user’s name

HH= = H

Logout and back in. The PCI hardware is now available for access.

$ 1s -1 /dev/galilx

crw-rw-——- 1 root galil 10, 56 Jun 9 11:07 /dev/galilpciO
$ echo -e "\x12\x16\r" > /dev/galilpciO

$ cat /dev/galilpciO

DMC1846 Rev 1l.la

Documentation

The documentation is left as a tarball to minimize disk usage. The latest release version of the user manual is
available at the following link.

e http://www.galil.com/sw/pub/all/doc/gclib/html/

Offline html
The following allows viewing of the html docs from the installation.

$ tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz html
$ firefox html/index.html

3.6 Fedora Linux

Tested versions

See the installation page for supported versions.

Installation
Note

Adding the package repository is a prerequisite to continue.

Install
Install gclib and gcapsd (recommended)

# dnf install gclib gcapsd

Approve Installed size and Importing GPG key, if prompted.

Uninstall
If gclib is to be removed from the system, the following commands may be used.

# dnf remove gclib gcapsd

Upgrading
To upgrade gclib to the newest release, use the following command.

# dnf upgrade gclib gcapsd
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List All Versions
Galil keeps older versions of gclib and gcapsd available for users. To list all versions use the following command.

$ dnf list gclib gcapsd --showduplicates

Installing Older Versions

Warning

When using gcaps, a compatible pairing of gcaps and gclib must be used. Galil maintains this compatibility
with installations and upgrades. Installing GDK will also install compatible versions of gclib and gcaps. When
installing older versions manually, it is the user's responsibility to ensure compatible versions.

Append the desired version's information after the package name.

# dnf install gclib-<version> gcapsd-<version>

An Example

On the developer's machine, gclib is installed with the current version.
$ sudo dnf install gclib gcapsd

After installation, the versions can be queried.

$ dnf list gclib gcapsd --installed

Installed Packages

gcapsd.x86_64 194-1 @galil-gcapsd
gclib.x86_64 506-1 @galil-gclib

On the deployment machine, the precise versions can now be specified.

$ sudo dnf install gclib-506-1 gcapsd-194-1

Serial Ports and USB

If access to the serial ports or USB (e.g. DMC-4103) is desired through gclib, the following will provide steps to
join the correct access group. If using USB, be sure the controller is powered and the usb is plugged in before
beginning.

Determine group with access

$ 1s -1 /dev/ttyUSB* /dev/ttyS«*

crw-rw———-. 1 root dialout 4, 64 Mar 3 16:39 /dev/ttysSoO
crw-rw-——-—. 1 root dialout 4, 65 Mar 3 16:39 /dev/ttySl
crw-rw—-—--—. 1 root dialout 4, 66 Mar 3 16:39 /dev/ttyS2
crw-rw-——-—. 1 root dialout 4, 67 Mar 3 16:39 /dev/ttyS3
crw-rw-——-. 1 root dialout 188, 0 Mar 6 11:08 /dev/ttyUSBO

In the above listing, dialout is the group that needs to be joined. uucp is another common group that may be listed.

Add the desired username to the group.

$ sudo gpasswd —a username dialout
[sudo] password for username:
Adding user username to group dialout

Log out and back in for change to take effect.

$ groups
username wheel dialout

gclib can now connect to serial and usb devices from user username.

PCI Controllers

If using a Galil PCI controller, the PCI driver must be installed.
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Install prerequisites

$ sudo dnf install kernel-devel-$ (uname -r)
$ sudo dnf install kernel-headers-$ (uname -r)
$ sudo dnf install gcc

Extract source and build driver

$ tar —-xf /usr/share/doc/gclib/src/gclib_pci.tar.gz
$ make

Copy module and add to kernel

$ sudo cp galilpci.ko /lib/modules/$ (uname -r)
$ sudo depmod
$ sudo modprobe galilpci

Add galil group for access to PCI

sudo groupadd -f -K GID_MIN=100 -K GID_MAX=499 galil

sudo cp 90-galilpci.rules /etc/udev/rules.d/

sudo udevadm control --reload-rules

sudo udevadm trigger

sudo usermod -a -G galil username #exchange "username" with actual user’s name

O »r U A

Logout and back in. The PCI hardware is now available for access.

$ 1s -1 /dev/galilx

crw-rw-—-—-- 1 root galil 10, 56 Jun 9 11:07 /dev/galilpciO
S echo —e "\x12\x16\r" > /dev/galilpciO

$ cat /dev/galilpciO

DMC1846 Rev 1l.la

Documentation

The documentation is left as a tarball to minimize disk usage. The latest release version of the user manual is
available at the following link.

* http://www.galil.com/sw/pub/all/doc/gclib/html/

Offline html

The following allows viewing of the html docs from the installation.

$ tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz html
$ firefox html/index.html

3.7 Raspberry Pi

Tested versions

See the installation page for supported versions.

Installation
Note

Adding the package repository is a prerequisite to continue.

gclib 1.31.6


http://www.galil.com/sw/pub/all/doc/gclib/html/
http://galil.com/sw/pub/all/doc/global/html/repositories.html

3.7 Raspberry Pi 31

Install

Install gclib and gcapsd (recommended)

# apt install gclib gcapsd

Note

See the Remote Server Example to make your Galil controllers easily accessible to other computers on your
network.

Uninstall

If gclib is to be removed from the system, the following commands may be used.

# apt remove gclib gcapsd

Upgrading
To upgrade gclib to the newest release, use the following command.

# apt install --only-upgrade gclib gcapsd

List All Versions

Galil keeps older versions of gclib and gcapsd available for users. To list all versions use the following command.

$ apt-cache madison gclib gcapsd

Installing Older Versions

Warning

When using gcaps, a compatible pairing of gcaps and gclib must be used. Galil maintains this compatibility
with installations and upgrades. Installing GDK will also install compatible versions of gclib and gcaps. When
installing older versions manually, it is the user's responsibility to ensure compatible versions.

Append the desired version's information after the package name.

# apt install gclib=<version> gcapsd=<version>

An Example

On the developer's machine, gclib is installed with the current version.
$ sudo apt install gclib gcapsd

After installation, the versions can be queried.

$ apt list --installed gclib gcapsd

Listing... Done

gcapsd/unknown, now 205-1 amd64 [installed]
gclib/unknown,now 517-1 amdé64 [installed]

On the deployment machine, the precise versions can now be specified.

$ sudo apt install gclib=517-1 gcapsd=205-1

Serial Ports and USB

If access to the serial ports or USB (e.g. DMC-4103) is desired through gclib, the following will provide steps to
join the correct access group. If using USB, be sure the controller is powered and the usb is plugged in before
beginning.
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Determine group with access

$ 1s -1 /dev/ttyUSBx /dev/ttySx

crw-rw-—---. 1 root dialout 4, 64 Mar 3 16:39 /dev/ttySO
crw-rw—----—. 1 root dialout 4, 65 Mar 3 16:39 /dev/ttySl
crw-rw-———. 1 root dialout 4, 66 Mar 3 16:39 /dev/ttyS2
crw-rw————. 1 root dialout 4, 67 Mar 3 16:39 /dev/ttyS3
crw-rw-——-—. 1 root dialout 188, 0 Mar 6 11:08 /dev/ttyUSBO

In the above listing, dialout is the group that needs to be joined. uucp is another common group that may be listed.

Check the user's group

The default pi username is already a member of dialout.

$ groups

pi adm dialout cdrom sudo audio video plugdev games users input netdev gpio i2c spi
If needed, add the desired username to the group.

$ sudo gpasswd —a username dialout

[sudo] password for username:
Adding user username to group dialout

Log out and back in for change to take effect.

$ groups
username wheel dialout

gclib can now connect to serial and usb devices from user username.

Documentation

The documentation is left as a tarball to minimize disk usage. The latest release version of the user manual is
available at the following link.

* http://www.galil.com/sw/pub/all/doc/gclib/html/

Offline html
The following allows viewing of the html docs from the installation, in the GUI mode.

$ tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz html
$ epiphany html/index.html

3.8 Apple OS X

Tested versions

See the installation page for supported versions.
Warning

The latest Apple support is for OSX 10.10, Yosemite. Please contact Galil if your application requires a current
version of Apple software.

Installation
On OS X, gclib is distributed in a dmg image. The following steps can be performed to install gclib.

Download the gclib dmg

» Open the dmg file and drag the gclib directory to the Applications alias or another installation location.
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Create Environment Variable (Optional)

» To provide maximum functionality, e.g. usage of the Python wrapper, add to the DYLD LIBRARY_PATH by
typing the following at a Terminal prompt.

$ echo "export DYLD_LIBRARY_ PATH=/Applications/gclib/dylib/:\$DYLD_LIBRARY_PATH" >> ~/.profile

* Log Out and back in to set the environment variable.

Make links for usb devices

If using the DMC4103 or another Galil USB product, symbolic links may be created so GAddresses() can list the

controllers.
Make a link from the Terminal.

user-mac:~ user$ #plug in DMC4103 usb cable

user-mac:~ user$ ls /dev/tty.usbx

/dev/tty.usbserial-A402L6KG

user-mac:~ user$ #make a symbolic link so gclib can list it

user-mac:~ user$ sudo 1ln -s /dev/tty.usbserial-A402L6KG /dev/tty.usbserial0
user-mac:~ user$ #gclib searches start at 0

user—-mac:~ user$ #GAddresses () will now list this device

Demonstrating with Python.

user-mac:~ user$ python

Python 2.7.10 (default, Jul 14 2015, 19:46:27)

[GCC 4.2.1 Compatible Apple LLVM 6.0 (clang-600.0.39)] on darwin
Type "help", "copyright", "credits" or "license" for more information.
>>> import gclib

>>> g = gclib.py ()

>>> g.GAddresses ()

{"/dev/tty.usbserial0’: '’}

>>> g.GOpen ("/dev/tty.usbseriallO -d")

>>> print (g.GInfo())

/dev/tty.usbserialO, DMC4143 Rev 1.2b, 9998

>>> g.GClose ()

>>> exit ()

user-mac:~ users$

Installed files

» The gclib shared object files

— /Applications/gclib/dylib/gclib.0.dylib
— /Applications/gclib/dylib/gclibo.0.dylib

» The gclib header files

— /Applications/gclib/include/gclib_errors.h
— /Applications/gclib/include/gclibo.h

— /Applications/gclib/include/gclib.h

— /Applications/gclib/include/gclib_record.h

« gclib documentation tarball
— /Applications/gclib/doc/gclib_doc.tar.gz
« Example source tarball
— /Applications/gclib/examples/gclib_examples.tar.gz
 Source files to modify/rebuild libgclibo.so
— /Applications/gclib/source/gclibo_229_src.tar.gz
+ GalilTools Communication Library (gcl) wrapper

— /Applications/gclib/source/gclib_gcl.tar.gz

gclib 1.31.6



34

Installation

Documentation

The documentation is left as a tarball to minimize disk usage. The latest release version of the user manual is

available at the following link.

* http://www.galil.com/sw/pub/all/doc/gclib/html/

Offline pdf

The following allows viewing of the pdf docs from the installation.
» Browse in the Finder to Applications/gclib/doc.
» Double-click the tar.gz file to extact it.
» Open the resultant directory.

» Open the pdf.

Offline html
The following allows viewing of the html docs from the installation.
» Browse in the Finder to Applications/gclib/doc.
» Double-click the tar.gz file to extact it.
+ Open the resultant directory.
+ Open the html directory.

+ Double-click index.html to open the help.
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Chapter 4

Language Support

Below are a number of examples demonstrating how to use the library with various languages and on various
platforms.

e C/C++
* Python
* Net

« Java

Can't find what you need? Please email support@galil.com,orcall Galil Applications.
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* Microsoft Visual Studio 2019 (16.0)
* Microsoft Visual Studio 2017 (15.0)
* Microsoft Visual Studio 2015 (14.0)
* Microsoft Visual Studio 2013 (12.0)
* MinGW

» Borland C++

* gcc (Linux)

+ clang (OS X)

4.1.1 Microsoft Visual Studio 2019 (16.0)

For brevity, these instructions assume the default installation location of C:\Program Files (x86)\Galil\gclib.

x_simple.c from VS2019 x64 Native Tools Command Prompt

Open x64 Native Tools Command Prompt for VS 2019.

Copy files

Navigate to a convenient, empty, writable location.

Set an environment variable for the base path.

>set base=C:\Program Files (x86)\Galil\gclib
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Copy simple example

>copy "%base%\examples\cpp\x_simple.c" .

Edit GOpen() call as necessary

In a text editor, open x_simple.c. Find the GOpen() call and update the address to match the desired hardware.
See the documentation for GOpen() for address formatting options.

Compile

>cl x_simple.c "%base$%$\lib\dynamic\x64\x.lib" -I "%base%\include"

Set Path to DLL

>set PATH=%base%\dl1l\x64\;%PATHS%

Execute

>x_simple.exe

version: 211.211.211 1.0.0.128

info: 192.168.0.42, DMCC640 Rev 1.0g, 9999
response: 3757802.0000

Using the pre-configured MSVC project (x_examples.cpp)

The directory gcliblexamples\msvc has fully functional MSVC examples. These instructions detail how to use the
2019 version.

» Copy gcliblexamples\msvc\2019_16.0\gclib_example to a convenient, writable location.

» Run gclib_example\gclib_example\copy _source.bat to copy the files.

» Open gclib_example\gclib_example.sin in Visual Studio 2019.

« In the Solution Explorer, expand the gclib_example and expand Source Files to show a listing of source.
» Open x_examples.cpp.

+ Find the GOpen() call and update the address to match the desired hardware. See the documentation for
GOpen() for address formatting options.

» Find the #if O preprocessor block enclosing the example calls. Change to #if 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions
are compatible with all Galil products.

+ Hit F5to build and run the example.

Create Project with MSVC 2019 (x_examples.cpp)

The instructions below allow building a project from scratch.

The following instructions were performed on Visual Studio Professional 2019 and can be extended to other Vi-
sual Studio versions. For brevity, the instructions assume the default installation location of C:\Program Files
(x86)\Galil\gclib and a build type of x64.

 Launch Visual Studio 2019.
« At the initial start window, Choose Create a new project.
* In the Create a new project window, choose Empty Project and click Next.

« Choose a Name, e.g. gclib_example.
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+ Choose a Location, e.g. C:\Users\user\Desktop.

» Uncheck Place solution and project in the same directory.

« Click Create.

* In the Solution Explorer, right-click on Source Files and choose Add-> Existing Item.

— Navigate to the gclib installation directory, then to examples\cpp in the installation directory.

— In File Name type x_x.cpp and click Add, this will filter out the files needed

— Select all files in the file chooser and click Add.

* In the Solution Explorer right-click on gclib_example, choose Properties.

— Click the Configuration Manager... button.

*

*

Under Active solution platform: choose x64.
Click Close.

— Highlight Configuration Properties in the side bar, and set the following project properties.

*

*

At the top of the window, change Configuration: to All Configurations and ensure Platform lists
Active(x64).

Configuration Properties -> C/C++ -> General -> Additional Include Directories add C:\Program
Files (x86)\Galil\gclib\include

Configuration Properties -> Linker -> General -> Additional Library Directories add C:\Program
Files (x86)\Galil\gclib\lib\dynamic\x64

Configuration Properties -> Linker -> Input -> Additional Dependencies add gclib.lib;gclibo.«
lib;{rest of text} where {rest of text} isthe original string that was in the cell. Note
the semicolons between library files.

Configuration Properties -> Debugging -> Environment add PATH=C:\Program Files
(x86)\Galil\gclib\dIl\x64;%PATH%

Click OK.

* In the Solution Explorer open x_examples.cpp. Find the GOpen() call and update the address to match the
desired hardware. See the documentation for GOpen() for address formatting options.

» Find the #1f 0 preprocessor blocks enclosing the example calls. Change to #if 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions
are compatible with all Galil products.

+ Hit F5to build and run the example.

4.1.2 Microsoft Visual Studio 2017 (15.0)

For brevity, these instructions assume the default installation location of C:\Program Files (x86)\Galil\gclib.

x_simple.c from VS2017 x64 Native Tools Command Prompt

Open x64 Native Tools Command Prompt for VS 2017.

Copy files

Navigate to a convenient, empty, writable location.

Set an environment variable for the base path.

>set base=C:\Program Files (x86)\Galil\gclib

Copy simple example

>copy "%base%\examples\cpp\x_simple.c" .
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Edit GOpen() call as necessary

In a text editor, open x_simple.c. Find the GOpen() call and update the address to match the desired hardware.
See the documentation for GOpen() for address formatting options.

Compile

>cl x_simple.c "%base%$\lib\dynamic\x64\*.1lib" -I "%base%\include"

Set Path to DLL

>set PATH=%base%\dl1l\x64\;$PATHS

Execute

>x_simple.exe

version: 211.211.211 1.0.0.128

info: 192.168.0.42, DMCC640 Rev 1.0g, 9999
response: 3757802.0000

Using the pre-configured MSVC project (x_examples.cpp)

The directory gcliblexamples\msvc has fully functional MSVC examples. These instructions detail how to use the
2017 version.

» Copy gcliblexamples\msvc\2017_15.0\gclib_example to a convenient, writable location.

* Run gclib_example\gclib_example\copy source.bat to copy the files.

» Open gclib_example\gclib_example.sin in Visual Studio 2017.

* In the Solution Explorer, expand the gclib_example and expand Source Files to show a listing of source.
» Open x_examples.cpp.

+ Find the GOpen() call and update the address to match the desired hardware. See the documentation for
GOpen() for address formatting options.

» Find the #1f 0 preprocessor block enclosing the example calls. Change to #1f 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions
are compatible with all Galil products.

« Hit F5to build and run the example.

Create Project with MSVC 2017 (x_examples.cpp)

The instructions below allow building a project from scratch.

The following instructions were performed on Visual Studio Professional 2017 and can be extended to other Vi-
sual Studio versions. For brevity, the instructions assume the default installation location of C:\Program Files
(x86)\Galil\gclib and a build type of x64.

 Launch Visual Studio 2017.

» Choose File->New-> Project.

* In the New Project dialog, choose Visual C++->Empty Project.
» Choose a Name, e.g. gclib_example.

+ Choose a Location, e.g. C:\Users\user\Desktop.

» Check Create directory for solution.
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+ Click OK.

+ In the Solution Explorer, right-click on Source Files and choose Add-> Existing Item.

— Navigate to the gclib installation directory, then to examples\cpp in the installation directory.

— In File Name type x_x.cpp and click Add, this will filter out the files needed

— Select all files in the file chooser and click Add.

« In the Solution Explorer right-click on gclib_example, choose Properties.

— Click the Configuration Manager... button.

*

*

Under Active solution platform: choose x64.
Click Close.

— Highlight Configuration Properties in the side bar, and set the following project properties.

*

*

At the top of the window, change Configuration: to All Configurations and ensure Platform lists
Active(x64).

Configuration Properties -> C/C++ -> General -> Additional Include Directories add C:\Program
Files (x86)\Galil\gclib\include

Configuration Properties -> Linker -> General -> Additional Library Directories add C:\Program
Files (x86)\Galil\gclib\lib\dynamic\x64

Configuration Properties -> C/C++ -> Code Generation -> Spectre Mitigation set to Disabled. If
your application will cross trust boundaries, consider Spectre and Meltdown vulnerabilities before
deploying.

Configuration Properties -> Linker -> Input -> Additional Dependencies add gclib.lib;gclibo.«
lib;{rest of text} where {rest of text} isthe original string that was in the cell. Note
the semicolons between library files.

Configuration Properties -> Debugging -> Environment add PATH=C:\Program Files
(x86)\Galil\gclib\dIl\x64;%PATH%

Click OK.

* In the Solution Explorer open x_examples.cpp. Find the GOpen() call and update the address to match the
desired hardware. See the documentation for GOpen() for address formatting options.

» Find the #1f 0 preprocessor blocks enclosing the example calls. Change to #1f 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions
are compatible with all Galil products.

+ Hit F5to build and run the example.

4.1.3 Microsoft Visual Studio 2015 (14.0)

For brevity, these instructions assume the default installation location of C:\Program Files (x86)\Galil\gclib.

x_simple.c from VS2015 x64 Native Tools Command Prompt

Open V52015 x64 Native Tools Command Prompt.

Copy files

Navigate to a convenient, empty, writable location.

Set an environment variable for the base path.

>set base=C:\Program Files (x86)\Galil\gclib

Copy simple example

>copy "%base%\examples\cpp\x_simple.c" .
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Edit GOpen() call as necessary

In a text editor, open x_simple.c. Find the GOpen() call and update the address to match the desired hardware.
See the documentation for GOpen() for address formatting options.

Compile

>cl x_simple.c "%base%$\lib\dynamic\x64\*.1lib" -I "%base%\include"

Set Path to DLL

>set PATH=%base%\dl1l\x64\;$PATHS

Execute

>x_simple.exe

version: 211.211.211 1.0.0.128

info: 192.168.0.42, DMCC640 Rev 1.0g, 9999
response: 3757802.0000

Using the pre-configured MSVC project (x_examples.cpp)

The directory gcliblexamples\msvc has fully functional MSVC examples. These instructions detail how to use the
2015 version.

» Copy gcliblexamples\msvc\2015_14.0\gclib_example to a convenient, writable location.

* Run gclib_example\gclib_example\copy source.bat to copy the files.

» Open gclib_example\gclib_example.sin in Visual Studio 2015.

* In the Solution Explorer, expand the gclib_example and expand Source Files to show a listing of source.
» Open x_examples.cpp.

+ Find the GOpen() call and update the address to match the desired hardware. See the documentation for
GOpen() for address formatting options.

» Find the #1f 0 preprocessor block enclosing the example calls. Change to #1f 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions
are compatible with all Galil products.

« Hit F5to build and run the example.

Create Project with MSVC 2015 (x_examples.cpp)

The instructions below allow building a project from scratch.

The following instructions were performed on Visual Studio Professional 2015 and can be extended to other Vi-
sual Studio versions. For brevity, the instructions assume the default installation location of C:\Program Files
(x86)\Galil\gclib and a build type of x64.

 Launch Visual Studio 2015.

» Choose File->New-> Project.

* In the New Project dialog, choose Visual C++->Empty Project.
» Choose a Name, e.g. gclib_example.

+ Choose a Location, e.g. C:\Users\user\Desktop.

» Check Create directory for solution.
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+ Click OK.

« In the Solution Explorer, right-click on Source Files and choose Add-> Existing Item.

— Navigate to the gclib installation directory, then to examples\cpp in the installation directory.

— In File Name type x_x.cpp and click Add, this will filter out the files needed

— Select all files in the file chooser and click Add.

* In the Solution Explorer right-click on gclib_example, choose Properties.

— Click the Configuration Manager... button.

*

*

Under Active solution platform: choose x64.
Click Close.

— Highlight Configuration Properties in the side bar, and set the following project properties.

*

At the top of the window, change Configuration: to All Configurations and ensure Platform lists
Active(x64).

Configuration Properties -> C/C++ -> Additional Include Directories add C:\Program Files
(x86)\Galil\gclib\include

Configuration Properties -> Linker -> General -> Additional Library Directories add C:\Program
Files (x86)\Galil\gclib\lib\dynamic\x64

Configuration Properties -> Linker -> Input -> Additional Dependencies add gclib.lib;gclibo.«
lib;{rest of text} where {rest of text} isthe original string that was in the cell. Note
the semicolons between library files.

Configuration Properties -> Debugging -> Environment add PATH=C:\Program Files
(x86)\Galil\gclib\dIl\x64;%PATH%

Click OK.

* In the Solution Explorer open x_examples.cpp. Find the GOpen() call and update the address to match the
desired hardware. See the documentation for GOpen() for address formatting options.

» Find the #1f 0O preprocessor blocks enclosing the example calls. Change to #if 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions
are compatible with all Galil products.

« Hit F5to build and run the example.

4.1.4 Microsoft Visual Studio 2013 (12.0)

For brevity, these instructions assume the default installation location of C:\Program Files (x86)\Galil\gclib.

x_simple.c from VS2013 x64 Native Tools Command Prompt

Open V52013 x64 Native Tools Command Prompt.

Copy files

Navigate to a convenient, empty, writable location, e.g. C:\temp.

Set an environment variable for the base path.

C:\temp>set base=C:\Program Files (x86)\Galil\gclib

Copy simple example

C:\temp>copy "%base%\examples\cpp\x_simple.c" .
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Edit GOpen() call as necessary

In a text editor, open x_simple.c. Find the GOpen() call and update the address to match the desired hardware.
See the documentation for GOpen() for address formatting options.

Compile

C:\temp>cl x_simple.c "%base%\lib\dynamic\x64\*.1ib" —-I "%base%\include"

Set Path to DLL

C:\temp>set PATH=%base%\dl1\x64\; $PATHS

Execute

C:\temp>x_simple.exe

rc: 0

version: 85.60.138

rc: 0

rc: 0

info: 10.1.3.17, DMC4020 Rev 1.2b, 291
rc: 0

response: 357247808.0000

Using the pre-configured MSVC project (x_examples.cpp)

The directory gcliblexamples\msvc has fully functional MSVC examples. These instructions detail how to use the
2013 version.

» Copy gcliblexamples\msvc\2013_12.0\gclib_example to a convenient, writable location, e.g. C:\temp.

» Run gclib_example\gclib_example\copy _source.bat to copy the files.

» Open gclib_example\gclib_example.sin in Visual Studio 2013.

« In the Solution Explorer, expand the gclib_example and expand Source Files to show a listing of source.
» Open x_examples.cpp

+ Find the GOpen() call and update the address to match the desired hardware. See the documentation for
GOpen() for address formatting options.

» Find the #1if 0 preprocessor block enclosing the example calls. Change to #if 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions
are compatible with all Galil products.

+ Hit F5to build and run the example.

Create Project with MSVC 2013 (x_examples.cpp)

The instructions below allow building a project from scratch.

The following instructions were performed on Visual Studio Professional 2013 and can be extended to other Vi-
sual Studio versions. For brevity, the instructions assume the default installation location of C:\Program Files
(x86)\Galil\gclib and a build type of x86 (win32).

 Launch Visual Studio 2013
» Choose File->New-> Project
* In the New Project dialog, choose Visual C++->Empty Project

« Choose a Name, e.g. gclib_example
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» Choose a Location, e.g. C:\Usersluser\Desktop

» Check Create directory for solution

« Click OK

« In the Solution Explorer, right-click on Source Files and choose Add->Existing ltem

— Navigate to the gclib installation directory, then to examples\cpp in the installation directory
— In File Name type x_x.cpp and click Add, this will filter out the files needed
— Select all files in the file chooser and click Add

« In the Solution Explorer right-click on gclib_example, choose Properties, highlight Configuration Properties,
and set the following project properties

— At the top of the window, change Configuration: to All Configurations and ensure Platform lists Active(«
Win32)

— Configuration Properties -> C/C++ -> Additional Include Directories add C:\Program Files
(x86)\Galil\gclib\include

— Configuration Properties -> Linker -> General -> Additional Library Directories add C:\Program Files
(x86)\Galil\gclib\lib\dynamic\x86

— Configuration Properties -> Linker -> Input -> Additional Dependencies add gclib.lib;gclibo.«
lib;{rest of text} where {rest of text} is the original string that was in the cell. Note
the semicolons between library files.

— Configuration Properties -> Debugging -> Environment add PATH=C:\Program Files (x86)\Galil\gclib\dIl\x86;%PATH%

* In the Solution Explorer open x_examples.cpp. Find the GOpen() call and update the address to match the
desired hardware. See the documentation for GOpen() for address formatting options.

» Find the #if O preprocessor block enclosing the example calls. Change to #if 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions

are compatible with all Galil products.

« Hit F5to build and run the example.

4.1.5 MinGW

The following instructions were performed with x86 Minimalist GNU for Windows (MinGW) installed from http«
://mingw-w64.sourceforge.net/download.php#mingw-builds
For brevity, these instructions assume the default installation location of "C:\Program Files (x86)\Galil\gclib".

Copy Files

Copy "gclib\examples\mingw" to a convenient, writable location, e.g. "C:temp". Run C: \temp\mingw\copy+«
_source.bat to copy all files.

x_simple.c

Edit GOpen() call as necessary

In a text editor, open x_simple.c. Find the GOpen() call and update the address to match the desired hardware.
See the documentation for GOpen() for address formatting options.
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Compile

+ Launch the MinGW terminal, e.g. Start -> All Programs -> MinGW-W64 project -> i686-4.9.1-posix-dwarf-
rt_ v3-rev3 -> Run Terminal.

+ Navigate to the directory with the files above.
» Compile the code.

C:\temp\mingw\>gcc x_simple.c -L. -lgclibo -1lgclib -o simple.exe

Execute

C:\temp\mingw>simple.exe

rc: O

version: 85.60.138

rc: 0

rc: O

info: 10.1.3.17, DMC4020 Rev 1.2b, 291
rc: O

response: 1584328.0000

Xx_examples.cpp

Review and Modify source

* In a text editor, open x_examples.cop. Find the GOpen() call and update the address to match the desired
hardware. See the documentation for GOpen() for address formatting options.

» Find the #if O preprocessor block enclosing the example calls. Change to #if 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions
are compatible with all Galil products.

Compile

+ Launch the MinGW terminal, e.g. Start -> All Programs -> MinGW-W64 project -> i686-4.9.1-posix-dwarf-
rt v3-rev3 -> Run Terminal.

» Navigate to the directory with the files above.
» Compile the code.

C:\temp\mingw>g++ *.cpp -L. —-lgclibo -lgclib -o examples.exe

Execute

C:\temp\mingw>examples.exe
Library version: 41.35.34

192.168.0.43, DMC4020 Rev 1.2b, 291

B R R R Tk R R R R

Example GRead() and GWrite() usage

B R R R TR

Read 155 QR bytes.

Fhrkhkhkhkhkhkhkhkhkhkhkhhhhkhk bk bk bk bk bk hArArrrrrhkhkhkhkhkhkhkhkhkhkhkhhhhkhk bk bk bk hkhkhkrkrrrrrhkhkhkhkhkhkhkhhkhkhkk*k
Example GCommand() usage

EEEEE SRS SRR EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE S
Revision report, "R"V

DMC4020 Rev 1.2b

Command Values
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val is 10
val is 11
val is 3.1415
val is 9.869

Command Trimming
> 95653016.0000
1<

> 95653016.0000<
>95653016.0000<

Receiving Binary Data
QR read 155 bytes

Error handling
QD correctly trapped, not allowed, try GArrayDownload()
DL correctly trapped, not allowed, try GProgramDownload ()

Modifying timeout
Burning program...OK

kA hkhkhhkhkhkhk kA hhhhhhhhkhhkhhhkhhhrhhh b hhkhkh bk hkhhhhhk bk hk bk hkhk bk h bk dk Ak bk dhrhkhkhkhkhkhkhkrhkhdhkrkhx*k
Example GProgramDownload() and GProgramUpload() usage

khkhkkhkhkhkhkhkkhkhkhkhhhkhhhh bk hhkhh bk kb hhhkhhhk bk hhhkhhh b bk hhkhk kb kb h b hkhkhkhhk bk hkhkhkhkhkhkhkhkhkhkhx*k
GProgramDownload () correctly errored. Can’t fit with level 3 compression
Program Downloaded with compression level 4

Uploading program:
#A;1=0;i=1i+1;i=1i+1;1i=1i41;1i=i+1;i=i+1;i=i+1;i=1i+1;1i=1i4+1;i=i+1;i=i+1;i=i+1;1
i=i+1l;i=i+1;i=1i+1;1i=1i+1;1i=1i+1;i=i+1;i=i+1;i=i+1;EN

Program executed as expected

R R R R R R R R Rk b b b b 2 b S S S
Example GArrayDownload() and GArrayUpload() usage

R R R R R R R R I R Rk kI S S S S S
2.0000, 4.0000, 6.0000, 8.0000, 10.0000, 12.0000, 14.0000, 16.0000, 18.000
0000

2.0000, 1.0000, 3.0000, 5.0000, 10.0000, 12.0000, 14.0000, 16.0000, 18.000
0000

3.0000, 5.0000, 10.0000

Ak hkhk kA hkhkhk kA hhhh A dhhkdkhhhkhhkhhhh bk hhhk kA h bk hkhhkhhhkh bk hk bk hkhkhkh Ak dkhhdhhkhkhkhkhkhkhkhkrhkhkdhkhxkhx*k
Example GRecord() usage

B R R T R R R e R R R R

QOR-based data record
38564
393216000

DR-based data record
38670
38772
38874
38976
39078
39180
39282
39384
39486
39588
39690

OR-based data record with offsets
39692
39692

Ak A A Ak Ak hk kA A d Ak bk h kA Ak hk Ak hk kA A A hhhhk kA hhkhhkh ko kA dkhhkhhkhkhkhkhhhhkhk kA rhhkhkkhkhkhkhhhhkhkkxxx
Example GMessage () usage

Ak Ak Ak hhkhhkhkhhhhhhhkhkhhhhhkhk Ak hAd bk bk hkhkhkhkhkhkhkhkhkhk bk hhkhkhkhkhkhkhhhkhkhArhkhhkkhkhkhkhrhhkhkhkhkxxx
0.0000

1.0000

2.0000
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.0000
.0000
.0000
.0000
.0000
.0000
.0000

O 0 ~J oy U b W

R R R R R R Rk b i b I 2 S S
Example GInterrupt () usage
R R R R R S R R R Rk kb 2k i 2 S S S

"UI 8" executed.

AR EEEEEEESEES S ESEE RS E R E SRR EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE S
Example GMotionComplete () usage

KA KKK KR AR A Ak A A A A A A A A A A A A A A A A A A AR AR AR A A A A A A A A A A A A Ak A A A A A A A A AR AR ARk Ak hhh kK *

Position: 0, O
Beginning independent motion... Motion Complete on A
Position: 8000, O

Position: 0, O
Beginning vector motion... Motion Complete on vector plane S
Position: 6000, O

examples.cpp executed OK
main() is finished. Press Enter to exit:

4.1.6 Borland C++
The following instructions were performed on:

Embarcadero C++ 7.10 for Win32 Copyright (c) 1993-2015 Embarcadero Technologies, Inc.

For brevity, these instructions assume the default installation location of "C:\Program Files (x86)\Galil\gclib".

Copy Files

Copy "gclib\examples\borland" to a convenient, writable location, e.g. "C:\temp". Run C: \temp\borland\copy«
_source.bat to copy all files.

C:\temp>cd borland

C:\temp\borland>copy_source.bat
\Program Files (x86)\Galil\gclib\examples\cpp\x_arrays.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_examples.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_examples.h
\Program Files (x86)\Galil\gclib\examples\cpp\x_gcommand.cpp
\Program Files (x86)\Galill\gclib\examples\cpp\x_ginterrupt.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_gmessage.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_gmotioncomplete.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_gread_gwrite.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_grecord.cpp
\Program Files (x86)\Galill\gclib\examples\cpp\x_nonblocking.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_programs.cpp
\Program Files (x86)\Galill\gclib\examples\cpp\x_simple.c

12 file(s) copied.
\Program Files (x86)\Galil\gclib\include\gclib.h
\Program Files (x86)\Galil\gclib\include\gclibo.h
\Program Files (x86)\Galil\gclib\include\gclib_errors.h
\Program Files (x86)\Galil\gclib\include\gclib_record.h

4 file(s) copied.
\Program Files (x86)\Galill\gclib\lib\dynamic\x86\gclib.lib
\Program Files (x86)\Galil\gclib\lib\dynamic\x86\gclibo.lib

2 file(s) copied.
\Program Files (x86)\Galil\gclib\dl1l\x86\gclib.dll
\Program Files (x86)\Galil\gclib\d1l1l\x86\gclibo.dll

2 file(s) copied.

C:\temp\borland>
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Modify Path

» Add Borland's compiler to the PATH variable.

C:\temp\borland>set PATH=c:\Program Files (x86)\Embarcadero\Studio\17.0\bin;%$PATH%

Convert lib files

C:\temp\borland>move gclib.lib _gclib.lib
1 file(s) moved.

C:\temp\borland>move gclibo.lib _gclibo.lib
1 file(s) moved.

C:\temp\borland>coff2omf.exe _gclib.lib gclib.lib

COFF to OMF Converter Version 1.2.0 Copyright (c) 1999-2009 Embarcadero Technologies, Inc.
All rights reserved.

C:\temp\borland>coff2omf.exe _gclibo.lib gclibo.lib

COFF to OMF Converter Version 1.2.0 Copyright (c) 1999-2009 Embarcadero Technologies, Inc.
All rights reserved.

x_simple.c

Edit GOpen() call as nhecessary

In a text editor, open x_simple.c. Find the GOpen() call and update the address to match the desired hardware.
See the documentation for GOpen() for address formatting options.

Com